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1 Introduction 
These Training Notes provide a reference during and following Civica Education’s VET – Work 
Placements training.  The VET Manual provides a comprehensive guide to the software. 
 
During training we will be working with fictitious data and all the exercises contained within this 
user guide refer to that data.  
 
 

1.1 Training Program 

 

Time Contents 

8.45 am/12.45 pm Coffee 

9.00 am/1.00 pm Introductions  

Logging On 

Tool Bars And Side Bars 

Administration Manager 

The VET Module 

VET Parameters  

VET Students 

Employer Maintenance 

10.15 am/2.15 pm Morning/Afternoon Tea 

10.35 am/2.35 pm Work Placements 

VET Reports 

Mail Merge 

Review 

11.45 am/ 3.45 pm Close 
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1.2 Training Outcomes 

 
At the end of the VET Training Program participants should be able to: 
 

 Add and edit VET parameters 

 Add and edit enrolling and non-enrolling VET Students 

 Enter and maintain Employer (Work Placement Provider) details  

 Enter and maintain Student Work Placement details 

 Create and use VET Reports 

 Creating Mail Merge letters 
 
 

1.3 Logging On 

Activity 
 

 Double click on the Integris icon on the desktop  
 

 
 

 Enter the User Name ADMIN 

 Press <Tab>  

 Enter the password KEYS.  

 Click on Login or press <Enter>. 
 

Note: In schools, each user has his or her user name and password, which enables access 
to particular sections of the software as determined by the school administration.  It is 
strongly recommended that you change your password once the software is installed in 
your school 

 
  

• 
• 
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1.4 The File Menu 

The file menu may be accessed by clicking on File in the top left of your screen. 
 

 
 

 Password enables the user to change his or her password.  For security purposes, it is 
recommended that this is done regularly. 

 Change User should be used to ensure that each person accessing Integris does so under 
their own user name and with their personal levels of access. 

 Lock Terminal may be used if the user needs to leave his or her computer temporarily, does 
not want to log off and does not want to allow access to anyone else.  Unlocking the terminal 
requires the user to enter his or her password again. 

 Report Destination allows the user to choose where to send any report created in Integris.  
The options are displayed below. 
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Activity 

Top Toolbar > File 

View each of the following items in the File menu 
o Password 
o Change User 
o Lock Terminal 
o Report Destination 

 

 
 

1.5 Accessing Help 

Activity 

Top Toolbar > Help > Help Contents and Index 

 Click Help in the top toolbar 

 Select Help Contents and Index 
 

 
 

 Highlight Integris VET Help 

 Click Help 

 View the VET manual  

 Close the manual and Help 
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2 The VET Module 

2.1 What is the VET Module? 

The VET module allows users to import essential VET information such as qualifications and units 
of competency, and to identify which qualifications and/or units they wish to offer in a given 
calendar year.  VET students can then be identified and enrolled into appropriate qualifications and 
units.  Recording of VET results may be done individually by student or in bulk by simultaneously 
entering results for all students undertaking a selected competency. 
 
The VET module also stores information on employers who are able to take students for work 
placement, and maintains a history of every student placement for a given employer.  Similarly, a 
record of each student’s work placement history is also kept.  This is the focus of this training 
program. 
 
A comprehensive set of VET reports is available, some of which enable the transfer of VET data 
from schools to authorities such as the School Curriculum and Standards Authority and the 
Department of Education. 
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2.2 Using the VET Sidebar 

 

Students enables users to identify VET students, enrol students in 
qualifications and units of competency, enter student’s results, view students’ 
work placement history and view details of units of competency such as mode 
of delivery, the designated Registered Training Organisation (RTO) and the 
result. 
 

Delivery Planning is where the qualification and competency offerings are 
identified for the selected calendar year, Registered Training Organisations 
(RTOs) are defined, and enrolments monitored. 
 

Employers enables users to list active and inactive employers, add or edit 
employer details, view all students placed with a particular employer, and place 
students with employers.  
 

Placement allows users to browse through their lists of students and 
employers and allocate work placements accordingly.  It is possible to locate a 
group of students or employers using the appropriate find tools.   
 

Reports allows users to produce a wide range of reports for internal use.   
 

Parameters is where items appearing in menus elsewhere in the VET module 
may be viewed and, in a few instances only, added, edited, deleted and made 
active or inactive according to the needs of the school. 
 

Utilities enables users to import AVETMISS data and codes, industry codes, 
and qualification and competency data, and to process the Active status of VET 
students. 
 

Control allows the Systems Administrator to change some of the default 
system preferences for all those using the VET module.  The system 
preferences may be tailored to suit a range of a school’s requirements.  
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2.3 VET Parameters 

VET > Parameters 

Information relating to reference data such as Industry areas, ANZSCO codes, Employment 
Categories etc. can be maintained from within Parameters.  Click on the Parameters icon in the 
VET sidebar to see the list of parameters.  
 

 
 
There are three types of VET parameters: 

1. Pre-populated parameters: These are parameters that are automatically loaded into the 
system when it is first installed.  They typically include parameters that will be the same across 
all schools (for example, the range of AVETMISS reporting parameters). 

2. Imported parameters: These parameters are empty when the system is first installed, but 
there are facilities to import them into the system.  They include parameters that will need to be 
updated on a regular basis such as qualifications and competencies 

3. User-definable parameters: These parameters are not pre-populated, and there is no facility 
to import them.  They are the parameters that will vary from school to school. 

 

Note: Only User-definable parameters can be added to, edited or deleted. 
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2.3.1 User-definable Parameters 

VET > Parameters 

The following parameters will be empty after installation and must be entered by the user:  
 

 Employer Correspondence Type 

 Employer Keywords 

 Student Correspondence Type 

 Workplace Category 

 WorkSafe Certificates 
 
It is the responsibility of each school to populate these parameters as applicable to their school 
operation.   

Employer/Student Correspondence Type 

These parameters allow the user to classify correspondence according to type, for example 
Employer Placement Start Letter or Student Notification of Placement. 

Employer Keywords 

The Employer Find tool has the facility to search for an employer based on a number of criteria.  
One of the criteria is keywords.  This parameter represents the possible list of keywords that can 
be assigned to an employer.  The user will choose up to six of the keywords from this list and 
assign them to an employer.  This will then permit the identification of the employers based on one 
or more of the keywords.  For example, if an employer is located next to a train station, the word 
train can be entered as an Employer Keyword parameter, and then assigned as a keyword to a 
number of employers.  Conducting a search of employers with the keyword train would then 
retrieve all employers located near a train station. 

Workplace Category 

This parameter is intended as a means of categorising work placements to assist in searching for 
the appropriate work placement type.  For example, an employer might only accept students on 
work experience.  Entering Work Experience as Workplace Category, and then assigning this 
category to the appropriate employers, will allow for the easy identification of employers that meet 
the criteria. 

WorkSafe Certificates 

There is a requirement in some work places for all workers to have completed a prescribed 
WorkSafe Certificate before being allowed on site.  This parameter allows for the entry of all 
WorkSafe Certificates.  These can then be attributed to students to make sure a student sent to a 
work place has the appropriate safety certification.  
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Activity 

VET > Parameters > Employer Correspondence Type 

 Click Modify/Add Parameters   

 Enter the Employer Insurance Letter as shown below 
 

 
 

 Click OK 

 Highlight Employer Insurance Letter and click Toggle Locked Status   

 Click Close 
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VET > Parameters > Employer Keywords 

 Click Modify/Add Parameters  

 Enter the TRAIN - Close to train station as shown below 
 

 
 

 Click OK  

 Highlight Close to train station and click Toggle Locked Status   

 Click Close 
 



 Integris VET Work Placement Training Notes.docx  19-Sep-13 

Page 17 of 79 

© 2013 Civica Education Pty Ltd 

 

VET > Parameters > Student Correspondence Type 

 Add and lock a PARINS - Parent Insurance Letter 
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VET > Parameters > WorkSafe Certificates 

 Click Modify/Add Parameters  

 Enter the Parameters listed below 
 

CON Building and Construction 

ELEC Electrical and Electronics 

HAIR Hairdressing 

MAN Manufacturing 

PRIM Primary Industry 

 

 
 

 Click OK to save 

 Highlight all the parameters in the list and lock    

 Click Close 
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2.4 VET Students 

VET > Students 

This window enables users to: 

 Identify which students are VET students   

 Enrol students in particular qualifications and units of competency 

 Bulk enrol selected students into selected competencies 

 Enter students’ results 

 Bulk enter student results 

 View work placement histories for each student 

 View details of units of competency such as mode of delivery, the designated RTOs and the 
results 

Note: There are two classes of VET students – enrolling and work experience only.  
Enrolling students can be enrolled into qualifications and competencies, and put on work 
placement.  Work experience students can be put on work placement, but cannot be 
enrolled into qualifications or competencies. 

Clicking Students on the sidebar will open the VET – Student List. 
 

 
 
The window will initially display all the VET students on the Current roll.  VET students on the 
Former, Admissions and External rolls can be viewed by selecting the appropriate roll status from 
the dropdown list on the toolbar.  The information provided by this window includes: 
 

 Surname 

 First Name 

 Year  

 Form 

 Whether or not the student is an active VET student 

 Whether the student is an enrolling student or a work experience student  

 School 

Note: Students originating from the local school will have the local school code appearing 
here.  Students from other schools will have that school’s code or the generic Other code to 
signify they have come from any other school. 

 FTE  
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 No. of Competencies  
 

2.4.1 VET Student List Toolbar 

 

 

Allows users to view VET students on the Current, Admissions, 
Former or External Rolls  

 

 
Opens VET Student Find.  The Find tool is used to select a specific group of VET students 
to be displayed in the list. 

 
Opens the Student Details window for the selected student(s).  If one student is selected, 
then that student’s details are displayed.  If more than one student is selected, the first 
student’s details are displayed and the selected students become the browse set for the 
Student Details window. 

 
Opens the main Integris Student Details window for the selected student.  This window will 
remain open so that the user can select another VET student in the list and the window 
will update to that student’s details. 

 
Opens a second window where the user can add and remove students from the list of VET 
Students. 

 
Opens the Student Groups window 

 
Speed Edit.  Opens a window where the user can speed edit the values for Active Status, 
School Code, FTE and Vocation. 

 
Bulk Qualification and Competency Enrolment - Opens the bulk competency enrolment 
window.  This permits the simultaneous enrolment of multiple students into the same 
qualification and units of competency or competency group.  

 
VET Competency Enrolment Speed Edit - permits editing of multiple competency 
enrolments simultaneously. 

 
Print selected student(s).  Prints the VET Student list for only the selected students. 

 
Prints the VET Student list as displayed. 
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2.4.2 Adding and Removing VET students 

VET > Students > Add/Remove VET students 

Students are added to the VET Students list by clicking the Add button    on the toolbar.  This 
will open a second window where the user can add or remove VET students.  
 

 
 

Enrolling Student 

VET students may be enrolling or work experience only.  An Enrolling student can be enrolled into 
qualifications and units of competency and can be linked to work placements.  A work experience 
student can be linked to a work placement record, but cannot be enrolled into a qualification or a 
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competency.  A student can be changed from one context to another at any time.  This can be 
done in Speed Edit. 

Originating School 

The complete set of VET Students at a particular school can consist of students enrolled in that 
school and who originate from other schools.  It is important to distinguish between VET students 
that come from the local school and those who originate from other schools.  If the student 
originates from the local school, the student is tagged with the local school code.  If the student 
originates from another school, the user can enter an alternative school code. 
 
Clicking This School will automatically enter the local school code in the Code field and display 
the local school name.   
 
If the user clicks Another School, the Code field will be enabled and the user can enter an 
alternative school code.  Tabbing out of the Code field will perform a match of the code entered 
against the list of codes in the Previous/Destination School parameter.  If there is a match, the 
school name will appear below the code.  If there is no match, the words Unknown School Code 
Entered will appear.  If the field is left blank, the code will be changed to Other and the text below 
the code will read Other School.   

 
Clicking the right arrow button will move the selected students in the Non VET Students list 
to the VET Students list.  Clicking the left arrow button will move the selected students in the 
VET Students list back into the Non VET Students list.  Whenever the list of VET Students 
is changed (by clicking either of the arrow buttons), the OK and Cancel buttons will replace 
Close.   Clicking the OK button will save the changes made to the VET Students’ list.  

Clicking Cancel will discard the changes and refresh the window to display the data as it was at 
the last save operation.  In both cases the Close button will replace the OK and Cancel buttons.  
Clicking the Close button will close the window. 

Note: Once students have been enrolled in units of competency, they cannot be removed 
from the VET student list, even if they withdraw from the course.  The fact that they were 
once enrolled must be included in AVETMISS reporting.  In this instance their results would 
be recorded as 40 - Withdrawn - or 99 – Enrolled in Error. 

The Non VET Student list can be filtered using the standard Integris Find Tool.  The Find Tool 
allows the user to define a query and store that query for future use.  If the Find Tool is used, and 
the query is not saved, the Display will show a message as in the following example. 
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Activity 

VET > Student  

  Click on Add/Remove VET Students  

  Click Student Find  

 To locate the students doing 1AWPL Workplace Learning, click on the T Sets/Cohorts tab and 
enter the query information as shown  

 

 
 

 Click Find  

 Click Select and Yes 

 Ensure that you have the Enrolling and This School radio buttons selected  
 

 
 

 Highlight the names in the Non-VET students list 

 Click the red chevrons  to move them to the VET Students list 

 Click OK to save 
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 Use Student Find  to locate students in 10.3 
 

 
 

 Highlight these students in the left-hand pane 

 Enter this group as No -work experience only VET students from this school 
 

 
 

 Click the red chevrons pointing right 

 Click OK 
 

Jillian Sorrell and Darryl Strother were added to the VET Student List in error 

 Highlight their names in the VET Student list  

 Click the red chevrons pointing left   

 Click OK 
 

  Add Students 

 Click on the headers in the VET Student list to sort according to different criteria 
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2.4.3 VET Student Speed Edit 

VET > Students > Speed Edit 

Clicking Speed Edit  will open the VET Student Speed Edit window.  The VET Student Speed 
Edit window allows the user to edit six major fields in bulk. These fields are: 
 

 Active Status 

 School Code 

 FTE  

 Enrolling 

 Vocation 1 

 Vocation 2 
 

 
 

The user can use VET Student Find to select a group of VET students. 
 
Clicking one of the four radio buttons in the Field area will populate the New Value field with the 
appropriate values related to that field.   
 

Selecting a new value and clicking Apply Changes  will modify the value for all selected 
students in the list.  Clicking OK will save the changes. 
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Activity 

VET > Students > Speed Edit 

 Click Speed Edit  

 Select Vocation 1 
 

 
 

 Click on the VET Student Find button   

 Find the Enrolling students in Year Group 11  
 

 
 

 Click Find, Select and Yes 
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 Highlight some of the students in the Speed Edit window 
 

 
 

 Choose 8 Information Technology from the New Value menu 
 

 Click Apply  

 Select some other students 

 Choose 4 Business/Finance as the New Value for these students 

 Click Apply 

 Click OK   
 

 Speed edit Vocation 1 for Non-enrolling Year 10 students 

 Close the Speed Edit window 
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2.5 Employer Maintenance 

When Employer is selected from the sidebar, a list window will appear showing all VET employers 
available to a school.  Within this list the Employer Name the Contact Person, Suburb, Intake and 
its Active status are shown.   
 

 
 
This list can also be sorted by clicking on the selected column heading. 
 

VET Employer List Toolbar 

 Opens a VET Employer Find window 
 

 Opens VET Employer Details for the selected employer(s) 
 

 Allows the user to add new Employer Details 
 

 Deletes the selected employer(s)  
 

 Toggles the employer active/inactive status 
 

 Print selected employer(s) 
 

 Print all employers 
 

Filtering the list of Employers 

 
 
The Employer list can be filtered to show Active Employers only, Inactive employers only or All 
Employers (active and inactive).  This is done by clicking the appropriate item in the drop down 
menu. 
 

Alternatively, the user can click on the Employer Search button  to open the Employer Find 
window where the user can find employers according to a wide range of search criteria 
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2.5.1 Employer Details 

VET > Employers > Employer Details 

The details for a specific employer can be viewed by selecting the appropriate employer in the list 
and clicking the Open Details button on the toolbar.     
 

 
 
This will open the Employer Details window and display the employer selected. If more than one 
employer is selected and Open Details is clicked, the list of selected employers will become the 
browse set for the Employer Details window.  Alternatively, the user can double click the employer 
record in the list to view that employer’s details. 
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Note: There is also a tab where the employer’s postal address may be entered if it differs 
from their physical or street address. 

 

 
 

VET Employer Details Toolbar 

 Browse Set Indicator: A grey button indicates that the browse set is empty.  A red button 
indicates the browse set contains data. 
 

 View Previous Employer  
 

 View Next Employer 
 

 Employer Find allows the user to search for a specific employer or group of employers, 
selecting a group of employers will enable the window browse set 

 Adds a new employer to the database 
 

 Allows editing of the employer details 
 

 Opens the VET Employer List 
 

 Prints the employer details including the list of student placement records 
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2.5.2 Adding Employers 

Clicking Add will put the window into data entry mode and allow the user to enter employer details 
by clicking on specific fields and/or tabbing from one field to the next.  Data entry mode will allow 
for the entry of data within the Employer Details area of the window only.  Once the employer 
details are saved, the user will be able add student placement details by clicking the Add button 
alongside the list. 
 
The Workplace Category list will allow the user to select multiple categories for an employer. 
 

 
 
Workplace Learning will be selected by default. 
 
The Search Keywords are selected from a predefined list and will allow the user to allocate 
certain keywords to an employer (for example, near bus stop) that can be used later to match 
students with prospect employers.  
 

 
 

 An employer can be made inactive by simply clicking on the Employer Active 
check-box to remove the tick.  This will prevent the system from allowing students to be placed 
with that employer.   
 

Adding Employer Vocation/Job Types 

Once the main employer details are entered the user is prompted to enter Vocation/Job Types 
information. 
 

 
 
Here, the user can specify the vocation/job types that the employer supports, and for each must 
specify the number of students they are prepared to place in a year and the appropriate contact 
person’s details.   
 
Further Vocation/Job Types may be added or existing information edited or deleted, through the 
toolbar that appears on the right of the Vocation/Job Types pane. 
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Note: Vocation/Job Types must be carefully chosen, as these will be recorded against 
students’ work placements. 

 

Editing VET Employer Details 

To change employer details click on Edit.  This will place the top half of the window in edit 
mode where employer details can be changed as required.  To save these changes click on OK. 
 

Printing VET Employer Details 

To print employer details and the list of students that have been placed, click on the print icon in 
the tool bar.   
 

Deleting VET Employer Details 

Employers can be deleted by selecting them in the VET Employer List and clicking Delete  on 
the toolbar.  An employer can only been deleted if the employer has no student placements.   
 
An alternative to deleting an employer is to make the employer inactive.  This is done by 
selecting the employer(s) and clicking the Toggle Active Status button on the toolbar.  
This changes all selected active employers as inactive and all selected inactive 
employers to be active. 
 

2.5.3 Student Placement  

VET > Employers > Employer Details > Student Placements 

Student placements details are shown on the Student Placement tab in VET Employer Details.  
This list will initially show all students placement records for the employer.  To restrict this to those 
students currently on placement or due for placement in the future, click the Current/Future only 
checkbox. 
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Clicking on Edit and then double clicking an item in the list will open a window that will show the 
student placement details.  The data displayed here may be edited in this window if required. 
 

 

Note:  Attendance details may only be edited in VET > Students > Student Details > 
Placement Details 

 

Adding, Editing and Deleting a Student Placement record 

It is possible to add, edit and delete student placement information in the VET Employer 
Details window by selecting the appropriate button from the tool bar on the right. 
 

2.5.4 Employer Correspondence  

VET > Employers > Employer Details > Correspondence 

The Correspondence tab contains a log of correspondence sent to the employer.  Many of the 
standard employer letters generated by the system will automatically put an entry into the log.  
There is also the option to manually add, edit and delete a log entry by clicking the appropriate 
button alongside the list 
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Activity 

VET > Employers 

 Double click on Hungry Jacks 

 View the details on the Details, Placements and Correspondence tabs 
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VET > Employers  

 Click on Add a Record   

 Enter the following information 
 

 
 

 Select the Postal Address tab  

 Check Postal address differs from physical address and enter the following 
 

 
 

 Click OK 
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 Click Yes to enter Vocation/Job Type details 

 Enter the Vocation details 
 

 
 

 Click OK to save  
 

 

 Add  a second Vocation/Job Type 
 

 
 

 Click OK twice and Close 
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 Click Add a New Employer   

 Enter the following employer details 
 

 
 

 Click OK  

 Click Yes, you do wish to add Vocation/Job Types 
 

 

 Enter the Vocation details 
 

 
 

 Click OK twice 

 Close 
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Entering Student Placements 

 Double click Civica Education  

 Click on the Student Placements tab 

 Click Edit  

 Click Add   

 Click No when asked if you want to add placements for multiple students 

 Click Student Find  

 Find students with the Vocation of Information Technology 
 

 
 

 Highlight the first student in the list and click Select 

 Enter the following details  
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 Click OK twice 

 Close 
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 Double click Burswood Casino  

 Click on the Student Placements tab 

 Click Edit in the top toolbar  

 Click Add  

 Click Yes you do wish to add placements for multiple students 

 Select the Vocation of Business/Finance 
 

  
 

 Click Find  

 Highlight the last three students in the list and click Select 

 If the following message is displayed, click OK 
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 Enter the following details and click OK twice 
 

 
 

 Click Edit   

 Highlight one of the students in the list and click Edit  on the right 

 Enter a note that the selected student is able to speak Japanese 

 Click OK twice 

 Close VET Employers 
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2.6 Placement 

VET > Placement 

 
 
This window provides a mechanism for browsing through lists of students and employers and 
allocating work placements accordingly.  It works on the concept that the user can locate a group 
of students and employers using the appropriate find tools.   
 
Once a suitable student/employer match is made, clicking the add button will open the student 
placement details window. 
 



 Integris VET Work Placement Training Notes.docx  19-Sep-13 

Page 44 of 79 

© 2013 Civica Education Pty Ltd 

 

 
 
Details of the placement may be entered and saved by clicking OK.  If the user attempts to place a 
student who is already on work placement then a warning message is displayed.   
 

Student Details 

The tabs under Student Details in this window contain the following information: 

 Student Summary 

 Enrolments 

 Placement History 

 Medical Information 

 WorkSafe Certificates 
 

 
 
Student Details may be edited in General > Student Details and VET > Student 
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Employer Summary  

The tabs under Employer contain the following information: 

 Employer Summary 

 Contacts 

 Placements 

 Vocation/Job Types 
 

 
 
Employer details may be edited in VET > Employers 
 

Activity  

VET > Placement  

 Highlight Sally Angus in the Student list on the left 

 View her details on each of the tabs below. 
 

 Highlight Hungry Jacks in the Employer list 

 View the details on each of the tabs below 
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2.6.1 Entering Placement Details 

Activity 

VET > Placement  

 Click Student Find  (left of centre at the top) 

 Select Information Technology from the Vocation drop-down menu 
 

 
 

 Click Find 

 Select the second student in the list  
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 Click on Find Employer  (on the right towards the top of the screen) 

 Find an employer with Information Technology as the Job Type 
 

 
 

 Click Find 
 

 

 Highlight the names appearing in both lists and click Add 

 Enter the Placement Details and click OK 
 

 
 

 View the Placement tab for both the student and the employer 
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2.6.2 Mail Merge using a .kst template 

It is possible to produce mail-merge letters from the Placements window.  In the first instance 
however, the mail-merge templates need to be created.  In this instance we will create a .kst 
template for the Parent Insurance letter.  The completed template will look like the example below.  
(The <enclosed> text indicates the merge fields.)   
 

 
<PG1Salutation> 
<PG1Address1> 
<PG1Town/Suburb> <PG1Postcode> 
 
Dear <PG1Salutation> 
 
WORKPLACE LEARNING (UNPAID) – INSURANCE COVER for: <FirstName> <Surname> 
Placement with: <EmployerName> 
Placement Dates: <PlacementStartDate> to <PlacementEndDate> 
 
The Department of Education (the Department) provides personal accident insurance and public liability 
insurance through RiskCover for students engaged in unpaid work placements allocated or arranged by the 
Department. 
 
The insurance covers, subject to certain conditions, the ‘gap’ costs over and above what is paid by Medicare 
or the student’s private health insurance for a student’s medical expenses, including dental, ambulance 
charges and surgical appliances. The insurance also covers direct travel between home and the workplace 
learning placement site.  
 
The Department of Education’s insurance does not cover accidental damage caused by the student unless 
negligence on the part of the student can be demonstrated. 
 
In the event of a workplace learning accident, the student will be asked to complete a workplace learning 
personal accident insurance claim form – available from: 
www.icwa.wa.gov.au/rc/forms/personalaccidentclaimform.pdf.  This form must be completed and forwarded 
to the school principal. 
 
In the first instance when making a workplace learning accident insurance claim, medical bills should be 
claimed through Medicare or your private health insurance.  In the event that reimbursement is required 
Medicare statements, private health insurer remittance and doctor’s and chemist’s receipts, where 
applicable, are to be forwarded to:  
 
Specialist Claims Team 
RiskCover 
GPO Box K 837  
PERTH WA 6842 
 
On approving the claim, RiskCover will send a cheque covering the difference between the Medicare/private 
health insurance cover and the total cost of the bills. 
 
Yours sincerely 
 
 
<PlacementStaff> 
Workplace Learning Coordinator 
 
19 September 2013 
 
Attachments 

Workplace details, Consent Form 

http://www.icwa.wa.gov.au/rc/forms/personalaccidentclaimform.pdf
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Note: The Parent Insurance letter has several pages, but we will only be working with the 
first page. 

 

Activity 

Start > My Computer  

 Navigate to C:\keys\INTEGRIS\MMTPL\LETTERS\VET 

Note:  At school the pathway will be K:\keys\INTEGRIS\MMTPL\LETTERS\VET 

 Double click on STUDENT.KST 
 
This document contains all the fields that might be used in a VET letter to students or parents. 

Note:  It is vital that the STUDENT.KST and not the EMPLOYER.KST is selected. 

 Click Open and navigate to C:\keys\INTEGRIS\MMTPL\LETTERS\VET 

 Double click on the Parent Insurance Letter.doc 
 
The text has been typed but the merge fields still need to be added. 
 

 In STUDENT.KST, highlight the merge field for PG1 Salutation and copy it 
 

 
 

 Place your cursor near the top of the Parent Insurance Letter and paste 

 <Enter> on the keyboard to create a new line in the letter 

 Copy the merge field for PG1Address1 from STUDENT.KST and paste it into the next line in 
the Parent Insurance Letter 

 <Enter> on the keyboard to create a new line in the letter 

 Continue to copy merge fields from STUDENT.KST and paste them into the Parent Insurance 
Letter until all of the merge fields have been added 

 File > Save As  

 Enter the File name: “Parent Insurance Letter.kst” 

Note: The quotation marks and .kst are essential. 

 Click Save 

 Close both documents and close Word 
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Once this template has been created it may be used many times.   

VET > Placement  

 Click Send letter to student(s)  
 

 
 

 Enter the following and click OK 
 

 

Note:  If you want to send letters to many students, click on the binoculars and Find, then 
click on each of the required names while holding down <Crtl> on the keyboard before 
clicking Send letter.  

 Navigate to C:\keys\INTERGRIS\MMTPL\LETTERS\VET 

 Double click on Parent Insurance Letter.kst 

 View the letter in Word, then close 
 

 
 

2.6.3 Mail Merge using a .csv file 

It is also possible to produce mail-merge letters to Employers from the Placements window.  Again 
however, the mail-merge templates need to be created first.  In this instance we will create a .csv 
file as the data source for the Employer Insurance letter.  The completed template will look like the 
example on the next page.  (The <<enclosed>> text indicates the merge fields.)   
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Sample Mail Merge Employer Insurance Letter 

«Emp_Name» 
«Emp_Address1» 
«Emp_Suburb» «Emp_Postcode» 
 
 
Dear «Emp_Contact» «EmpCon_Surname» 
 
Re:  Work placement for: «FirstName» «Surname» 
 
The Department of Education provides insurance cover for the duration of the student workplace learning 
placement.  This insurance cover applies to students who are on unpaid work placement, when arranged or 
allocated by the school only.  It covers, subject to certain conditions, the student’s medical expenses, 
including dental, ambulance charges and surgical appliances over and above what may be payable by 
Medicare or the student’s private medical health insurance. 
Employers (and self-employed persons) have a legal responsibility to ensure that their work and the work of 
their employees do not adversely affect the safety and health of non-employees, including any students 
undertaking work placement.  The employer must take the necessary action to protect the safety and health 
of these students.  This may include showing them how to work safely, ensuring the workplace is safe, 
ensuring reasonable care is taken not to expose students to hazardous situations, and providing appropriate 
supervision. 
 
Accident Procedure 
If an accident occurs involving a student on work placement, then: 

1. normal arrangements for medical assistance must be made immediately.  It is preferable to have the 
student attend a public hospital.  NB: Students are not workers’ compensation patients and should not be 
treated as such by the doctor; 

2. employers should notify parents and the school immediately; and 

3. a medical certificate must be issued by the doctor attending the student. 
 
Public Liability insurance arrangements 
The Department of Education is a State Government agency and as such is subject to the policies and 
directives of the Western Australian Government. 
The Department’s insurance coverage is placed with the Western Australian Government’s self insurance 
managed Fund – RiskCover. The Department of Education provides both personal accident insurance and 
public liability insurance for students engaged in unpaid work placements allocated or arranged by the 
Department’s schools. 
It is a requirement of the Department of Education that a business accepting students on workplace learning 
has in place its own Public Liability insurance to a minimum of $5 000 000 for any one occurrence. 
RiskCover will manage claims on behalf of the Department, as required, in accordance with agreed 
arrangements. 
The Department of Education’s insurance policy does NOT cover accidental damage caused by the student 
unless negligence on the part of the student can be demonstrated. 
 
Should you have any further queries please do not hesitate to contact me.   
 
Yours faithfully 
 
 
 
Workplace Learning Coordinator 
 
19 September 2013 
cc: Parent/guardian   Encl.: Insurance Acknowledgment Form 
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Activity 

VET > Placement  

 Click Send letter to employer(s)  
 

 
 

 Enter the following and click OK 
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 Enter a File name and click Save 
 

 
 

 Click OK 
 

 
 
The .csv data source may now be linked to the mail merge letter. 
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 Open Word 

 Click Open  and navigate to C:\keys\INTEGRIS\MMTPL\LETTERS\VET 

 Double click on Insurance letter for Workplace Supervisor 
 
The text has been typed but the merge fields still need to be added. 
 

 Click Tools\Letters and Mailings\ Mail Merge  
 

 
 

 Click Next: Starting document 
 

 
 

 Click Next: Select recipients 
 

 
 

 Click Browse 
 

 
 

 Navigate to C\keys\Integris\Outbox 
 

 
 

 Double click on Employer Insurance.csv 
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 Ensure that only Sally Angus is selected and click OK 

 Click Next: Write your letter 
 

 
 

 Place your cursor at the top of the letter and click More items 
 

 
 

 Highlight Emp_Name and click Insert 
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 <Enter> on the keyboard to create a new line in the letter  

 Click More items 

 Highlight Emp_Address1 and click Insert then Close 

 <Enter> on the keyboard to create a new line in the letter 

 Repeat these steps until all merge fields have been added 
 

 Save  your template 
 
You will now be able to use it many times. 
 

 Click Next: Preview your letters 
 

 
 
If the letter is OK: 
 

 Click Next: Complete the merge 
 
At school you would now choose to Print the letters. 
 
If the letter is not OK: 
 

 Click Previous: Write your letter 

 Make the required changes and save  again 

 Click Next: Preview your letters 
 

 
 
If the letter is OK: 
 

 Click Next: Complete the merge 
 
At school you would now choose to Print the letters. 
 

 Close the letter and Word without saving 
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2.6.4 Entering Work Experience Details 

Activity:  

VET > Placements 

 Click Student Find (left of centre at the top) 

 Enter Non-Enrolling in the Context field and click Find 
 

 
 

 Highlight the first student in the list and click Select 
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 Click Employer Find (on the right towards the top) 

 Check Work Experience and click Find 
 

 
 

 

 Select Hungry Jacks 

 Highlight both names and click Add 

 Enter the placement details  
 

  
 

 Click OK 

 View the Placement Details for both student and employer 

 Close the Placement window 
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2.7 VET Student Details 

VET > Students  

The VET Student Details window is launched by either clicking Student Details  in the VET 
Student List toolbar or double clicking on a student’s name.  
 

  
 
Browsing and navigation in this window is similar to the standard Integris Student Details window.  
There are the standard previous, next, find and roll selection items in the toolbar.  There is also the 
standard fast find field at the bottom of the window. This permits a user to enter a student’s 
surname, or part thereof, or the student’s reference number and the system will find the matching 
records.  It works in exactly the same manner as the Student Search field in the main Integris 
Student window, except that it searches just the list of VET Students. 
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VET Student Details Toolbar 

 

Browse Set Indicator - grey button indicates that the browse set is empty, a red 
button indicates the browse set contains data 

 

Roll Status 

 
View Previous Student 

 
VET Student Find searches through the list of VET Students only 

 
View Next Student  

 
Open standard Integris Student Details window 

 
Student Enrolment View - click to view the student’s qualification and competency 
enrolment details, as well as competency results 

 
Placement View - click to view student placement information 

 
Miscellaneous View - click this button to view student miscellaneous information 
required reporting bodies 

 
Open VET Student List 

 
Prints the data in the selected view 

 
 

Activity: 

VET > Students 

 Double click on Sally Angus 

 View her enrolment details 

 Click the Competencies tab and view her competency enrolments 

 Click the Preferences tab  and view her courses for this year 

 Click View Miscellaneous Details  

 View the information on the General, AVETMISS and Correspondence tabs 

 Click View Placement Details  
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 Use Search to locate Jenny Black’s records  

 Click Add  to the right of the Placement History pane   

 Click Employer Find  

 Find an employer with the Vocation/Job Type of Business/Finance  
 

 
 

 Select Burswood Casino 

 Enter the following placement details  
 

 
 

 Click OK 
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VET > Student  

 Highlight 22 August and click on the Edit pencil to the right of the pane   

 Remove the tick next to Student attended on this day and enter a note 
 

 
 

 Click OK 
 

 Highlight 26 September and click Edit 

 Place a tick next to Staff member attended on this day 

 Select a staff member 

 Enter a note 
 

 
 

 Click OK 
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 Click Add to the right of the Attendance pane 

 Enter these details 
 

 
 

 Click OK 

 Close VET Students 
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2.8 VET Reports 

The Integris VET module provides schools with a range of VET reporting options.  VET Reports 
are accessed via the Reports icon in the VET sidebar.  
 

  
 

2.8.1 Types of VET Reports 

VET Reports are sorted by functional areas. 
 

School Curriculum 
and Standards 
Authority Reports 

These reports are designed to provide the School Curriculum and 
Standards Authority with data in a pre-determined format. 

Qualification 
Reporting 

Enables the school to view VET data by qualification.  Hardcopy outputs of 
each report can be produced 

Competency 
Reporting 

Enables the school to view VET data by unit of competency.  Hardcopy 
outputs of each report can be produced 

Student Reporting 
Enables the school to view VET data by student.  Hardcopy outputs of 
each report can be produced 

Employer Reporting 
Enables the school to view VET data by employer.  Hardcopy outputs of 
each report can be produced 

Standard Letters – 
Mail Merge 

Provides the school with the functionality to produce export files into MS 
Word 

RTO Reporting 
Provides the school with the functionality to view VET data for a given 
RTO, AVETMISS reporting is undertaken here 

RTO Certification Allows schools with active RTO status to print certificates 

VET Exports 
Provides the school with the functionality to export VET data for statistical 
analysis  
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Submitting Authority 
Reporting 

Provides the RTO with the information about the authority submitting 
AVETMISS data  

Industry Area 
Reporting 

Reports on competency offerings by associated industries 

 
 

2.8.2 Accessing VET Reports 

Accessing other VET reports is done through VET > Reports by clicking on the relevant folder 
holding a group of reports and clicking on the name of the required report. 
 

   
 
Where default Main Title and Footer fields appear in the report set-up window, the user can edit 
the title and/or footer. 
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A number of reports make use of the Find tool in selecting settings.   

 Click on the Find tool icon and enter search criteria 

 Click Find 
 
If more than one value matches your criteria, a list of results will be displayed.  
 

 Select one or more items  (use <Ctrl> to select several items from the list) 

 Click Select 
 
Some reports display the number of selections made.  
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2.8.3 Placement Reports 

Activity 

VET > Reports > Student Reporting 

 Select Placement Details  

 Find the students whose surnames begin with A 

 Click Select  

 Enter a date range of the current year and click Find 
 

 
 

 Print the report to the screen  
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VET > Reports > Employer Reporting 

 Select Placement Summary 

 Select Active Employers from the Query drop down menu 

 Enter a date range of the current year and click Find 
 

 
 

 Print the report to the screen 
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VET > Reports > Employer Reporting 

 Select Scheduled Placement Details 

 Select Active Employers from the Query drop-down menu 

 Click Report Type Active Placements for TODAY’S date 
 

 
 

 Print the report to the screen 

 Click Report Type Future only and Print again 
 

 
  



 Integris VET Work Placement Training Notes.docx  19-Sep-13 

Page 70 of 79 

© 2013 Civica Education Pty Ltd 

 

 

2.8.4 Mail Merge 

Activity  

VET > Reports>Standard Letters – Mail Merge 

 Highlight Students and Placements 

 Choose VET Students on the Current Roll from the Query drop down menu 

 Click on Select Folder  

 Highlight C:\keys\Integris\Outbox and click Select 

Note:  At school the pathway will be K:\keys\Integris\Outbox 

 Choose Parent Insurance Letter  as the Correspondence Type 

 Check the Record Correspondence box 

 Enter the dates: 1st January to 31st December  

 Check Surname, First Name, PG1 Salutation, PG1 Address 1, PG1Town/Suburb, PG1 
Postcode, Employer Name, Placement Start Date, Placement End Date and Placement 
Staff  

 Ensure Save Fields is checked 

Note:  Checking Save Fields ensures that the next time this Correspondence Type is 
selected the required fields are already checked. 
 
It is not possible to save fields for an unspecified Correspondence Type. 
 
Correspondence Types may be added in VET > Parameters. 
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 Click Print  

 Read the prompt and click OK 
 
It is now possible to merge the data exported from Integris with a mail merge template in Word. 
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 Open Word and the document C:\Keys\Integris\MMTPL\Letters\VET letters\mm\ Insurance 
Letter for Parents mm 

Note: VET mail merge templates are available from 
http://det.wa.edu.au/curriculumsupport/vetis  Navigate to Resources and Support. 

 Click Tools\Letters and Mailings\ Mail Merge  
 

 
 

 Click Next: Starting document 
 

 
 

 Click Next: Select recipients 
 

 
 

 Click Browse 
 

 
 

 Navigate to C\keys\Integris\Outbox 
 

 
 

 Double click on PARINS.csv 
 

http://det.wa.edu.au/curriculumsupport/vetis
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 Click OK 

 Click Next: Write your letter 
 

 
 

 Click Next: Preview your letters 
 

 
 

 Preview all your letters 
 

 
 

 Close the letters without saving 
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VET > Reports > Standard Letters – Mail Merge 

 Highlight Employers and Placement  

 Choose All Employers from the Query drop down menu 

 Click on Select Folder  

 Highlight C:\Keys\Integris\Outbox and click Select 

Note:  At school the pathway will be K:\keys\Integris\Outbox 

 Choose Employer Placement Insurance Letter as the Correspondence Type 

 Check the Record Correspondence box 

 Enter the dates: 1st January to 31st December  

 Check Employer Name, Employer Address 1 and 2, Employer Suburb, Employer 
Postcode, Employer Contact Title, Employer Contact Surname, Placement Staff, 
Surname and First Name  

 Check Save Fields 

Note:  Checking Save Fields ensures that the next time this Correspondence Type is 
selected the required fields are already checked. 
 
It is not possible to save fields for an unspecified Correspondence Type. 
 
Correspondence Types may be added in VET > Parameters. 

  
 

 Click Print and OK 
 
It is now possible to merge the data exported from Integris with a mail merge template in Word. 
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 Open the document C:\Keys\Integris\MMTPL\Letters\VET\mm\Employer Insurance Letter 
for Workplace Supervisor mm.doc  

Note: VET mail merge templates are available from 
http://det.wa.edu.au/curriculumsupport/vetis  Navigate to Resources and Support. 

 Click Tools\Letters and Mailings\Mail Merge  
 

 
 

 Click Next: Starting document 
 

 
 

 Click Next: Select recipients 
 

 
 

 Click Browse 
 

 
 

 Navigate to C\keys\Integris\Outbox 
 

 
 

 Double click on EMPINS.CSV 
 

http://det.wa.edu.au/curriculumsupport/vetis
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 Click OK 

 Click Next: Write your letter 
 

 
 

 Click Next: Preview your letters 
 

 
 

 Preview all your letters 
 

 
 

 Close the letters without saving 
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Note: These mail merge examples are based on Word 2003.  Users with other Word versions 
may find the process somewhat different to that used here. 

 

Review 

Complete each of the following tasks, noting the pathway you used in each instance.  

1. Add the Aboriginal students in Year 10 as enrolling VET students. 
 
 
 
 
 
2. Speed Edit some non-enrolling Year 10 students’ status from work experience only to 

enrolling. 
 
 
 
 
 
3. Enter the details of an employer who has links to your school. 
 
 
 
 
 
 
4. Enter work placement details for a student with the employer just added.  (There is more than 

one option here.) 
 
 
 
 
 
 
5. Enter details of a staff visit to the student’s workplace. 
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3 Support 
Should you require support please contact the Customer Service Centre (CSC) at the Department 
of Education. 
 
Contact details below: 

3.1 Phone (CSC) 

Metro: 9264 5555 
Country: 1800 012 828 
 
Please be prepared to supply your ID number, contact details and a brief description of the 
problem. 

3.2 Fax (CSC) 

9264 4701 
 
Please include your ID number, contact details and a brief description of the problem. 

3.3 Email (CSC) 

customer.service.centre@education.wa.edu.au 
 
Please include your ID number, contact details and a brief description of the problem. 
 

4 Online Manuals and Training Notes 

4.1 Civica Education 

Online manuals and training notes are available to download in PDF format from the Civica 
Education website. 
 
http://www.civicaeducation.com.au/  
 
Select Integris Support. 
Log in to Western Australian SIS Schools. 
Username: school 
Password: help 
 

4.2 STIMS Project 

The Department’s Student Information Management Project (STIMS) website has numerous 
factsheets and support documents for all SIS Administration modules. 
 
http://www.det.wa.edu.au/intranet/stims  
 
Links to the Integris Manuals are also available from the STIMS website or by going to Help within 
Integris. 
 

mailto:customer.service.centre@education.wa.edu.au
http://www.civicaeducation.com.au/
http://www.det.wa.edu.au/intranet/stims

